IBSU Scientific Article Publishing Journals Handbook

Compiled by Akinnola N. Akintunde and Victoria Baramidze*

Table of contents
About IBSU Journals page 1
Online submission Page 2
Editor’s Notes Page 2
Editors expectations of a scientific paper Page 3
General article writing rules and deadlines for IBSU Journals Page 4
American Psychological Association (APA) Style Page 7
APA Style – Automating Bibliographies Page 7
Designer’s Notes to Authors Page 11
Sample Paper Page 12

About IBSU Journals

The International Black Sea University (IBSU) publishes Journals biannually in June and December. Intending Authors are advised to utilize the period between January and April to prepare and submit their article meant for June publication and July to October to prepare and submit their article meant for December publication. This will give us enough time to review, correct and publish on schedule. The Journals are listed below:

**IBSU Journal of Business**
ISSN: 2233-369X

**IBSU Journal of Education**
ISSN: 2298-0172

**IBSU Journal of Humanities**
ISSN: 2298-0245

**IBSU Journal of Social Sciences**
ISSN: 2233-3878

**IBSU Journal of Technical Science and Technologies**
ISSN: 2298-0032

Intending Authors are required to register with a Username and a chosen Password to gain access to the submission portal. This will allow communications with Editors, reviewers and the editorial desk staff if they so wish. Otherwise the normal submission channels are still open through E-mail attachment, or by post.

*Associate Professor at the Faculty of Engineering and Computer Science, International Black Sea University, Tbilisi, Georgia, e-mail: aakintunde@bsu.edu.ge and vbaramidze@bsu.edu.ge
Online submission

Submissions to IBSU Journals can be done online to any of the five Journals being published through the following links:

- **IBSU Journal of Business** ISSN: 2233-369X
- **IBSU Journal of Education** ISSN: 2298-0172
- **IBSU Journal of Humanities** ISSN: 2298-0245
- **IBSU Journal of Social Sciences** ISSN: 2233-3878
- **IBSU Journal of Technical Science and Technologies** ISSN: 2298-0032

The articles will be checked by experienced blind reviewers and be published in the relevant Journal.

The papers / articles can be researched in any relevant field to any of the Journal listed above

**EDITOR’S NOTE**

*IBSU Journals* publishes manuscripts related to relevant areas in Business, Education, Humanities, Social Sciences and Technical Science and Technologies. Each paper submitted is refereed to blind reviewers from relevant disciplines.

**Key instructions - All manuscripts must:**

- Not be under consideration with any other journal;
- Be written in English. It is recommended that an English check of the manuscript by a competent and knowledgeable person be completed before submission. ONLY manuscripts that are written in clear and concise *English*, will be accepted for review;
- Be in Microsoft Word format, (using *Arial,* *APA style,* font size-10, for bibliographies line spacing-1.5);
- Include an abstract of not more than 300 words, in English;
- Key words (not less than 3 and not more than 10 words, in alphabetical order)

*Please refer to the brief on “Editor’s expectations of a scientific paper” presented below*

Authors are asked to pay particular attention to the accuracy and correct presentation of references (please read the instructions given below carefully), IBSU Journals employs an APA Style Formatting for references as follows:

- For books: Author surname, initials. (year). Book Title. Publishing house and publication place
- For internet sources: Author surname, initials (if available). (year or, n.d. – non-dated (if not available) ). Article or Web-site title. Retrieved on… (date) from (address)
- For quotations page should be indicated inside the text or article
SUBMISSION:

Types of manuscripts accepted:

- New, significant, innovative and original findings that is suitable as a scientific research article.

Submit manuscripts as a file attachment by e-mail or online to the following addresses:

IBSU Journal of Business
IBSU Journal of Education
IBSU Journal of Humanities
IBSU Journal of Social Sciences
IBSU Journal of Technical Science and Technologies

Further information will be sent by e-mail upon your request.

Editor’s expectations of a scientific paper:

- **Title** – offers a brief description of the research and includes the author(s).

- **Abstract** – is a brief but comprehensive summary of the research, usually a paragraph long.

- **Introduction** – this section gives background information about the research problem. It often includes information on similar studies, explains the reason(s) for conducting the research and offers any additional information that might be needed to understand the research problem or research that is being described in the paper. *Sometimes the Introduction section isn’t titled, but it is always present.*

- **Methods** – gives a detailed description of how the research was conducted. Some methods that could be used include surveying, experimentation and observation. *This is occasionally titled Methodology instead.*

- **Results** – the ‘answer’ to the research question. The Results section shows, describes and analyzes the data found by the research.

- **Discussion** – discusses the implications of the results found. The Discussion section may also compare, contrast and discuss the data obtained to other research articles on similar topics. *It is sometimes called the Conclusion or divided into a ‘Discussion’ section and a ‘Conclusion’ section.*

- **References** – is a list of citations from other books, journal articles, reports or studies mentioned in the article *Sometimes called Works Cited or Bibliography. References (reference list in alphabetical order).*

NOTE:

- *Our Journals* reserves the right to make editorial changes in style and format.
- Articles submitted are sent to blind reviewers and a decision is made by the editors in the light of their comments. *A decision should be received within three to four weeks.*
General article writing rules and deadlines

June Publication Deadline → 30th March
December Publication Deadline → 31st October

Articles received after any deadline for any of our Journals will be automatically reviewed for the next issue of that Journal.

Articles should be written in English.
Please follow formatting guidelines below for writing your article.

1. Change word ruler parameters from inches/cm to mm as follows (Office 2010):
   *File button* → *Word Options* → *Advanced* → *Display* → *Show measurements in units of* → *choose mm from dropdown menu.*

2. Go to Page Layout menu, adjust
   - Size -- A4
   - Orientation -- Portrait
   - Margins – click on Margins and choose Custom margins at the bottom.

   Top =34 mm  
   Bottom =34 mm  
   Right =18,5 mm  
   Left =18,5 mm

3. Use a single column format for the article title, author’s name, abstract and keywords (you can access control to column formats from Page Layout – Columns – More columns).
Use a two column format for the rest of the document: equal column width, Space between columns = 8 mm, “This point forward”

4. Article begins with a title, typeset in Arial, bold, 12 pt, center aligned
5. Author’s name follows the title, Name is sentence case, SURNAME is capitalized, typeset in Arial 10 pt, bold, left aligned
6. Include Abstract next: Abstract Title -- Arial, 10pt, bold, left aligned, Abstract Text -- Arial, 10pt, normal, justified.
7. Keywords: Keyword Title --Arial, 10pt, bold, left aligned.
   Keyword Text --Arial, 10pt, normal, justified, no less than 3 and no more than 10 words, in alphabetical order.
8. Footer: A footnote mark needs to be set next to the author’s name with an asterisk (use superscript), the footer should contain author’s academic title, affiliation and contact information. The footer text is typeset in Arial 8 pt, normal. IBSU corporate mail has to be used as a contact mail whenever possible.
   To create a footer
      1) click anywhere on the first page of your paper,
      2) use Insert/Footer/Alphabet option in the menu,
      3) choose ‘different first page’ option, type the text (academic title, affiliation, contact information) in the footer on the first page, you may adjust the fonts and page numbering – delete the word Page and center align the number.
      4) Go to the 2nd page footer, using ‘Footer’ option on the left side of the menu, choose Alphabet again, and delete [Type text]. At that same time you can adjust page numbering – delete the word Page and center align the number (on both first and second pages).
5) Exit Header and Footer Tools.

9. Line spacing: use 1.5 for line spacing for the entire article.

10. Please include Introduction and Conclusion sections in your papers.

11. Section/subsection Titles in Article -- Arial, 10pt, bold, left aligned.

12. Article text -- Arial, 10pt, normal, justified. Bold and italics can also be used if necessary.

13. All text used in graphics, tables and visuals should be readable, of the same font Arial, and the same size, 10pt if it’s standard text, for title - 12pt and bold;

14. Figure or image Caption text must be written below the figure, center aligned, font size 9pt, bold for the word Figure, italic for the caption text. It is recommended to specify the source.

   See recommendations below on image quality requirements from the journal’s designer. Insert the image into your word file exactly where you would like it to appear in the final version. Size it to be of the width consistent with the column width (about 81 mm).

15. Table Caption text must be located above the table, center aligned, font size 9pt, bold for the word Table, italic for the caption text. It is recommended to specify the source. Table width must be consistent with the column width (about 81mm). There is no limitation for length.

16. Use only • or - or 1,2,3,... for listing.

17. We recommend/suggest you to use online latex equation editor in http://www.codecogs.com/latex/eqneditor.php

   Equations must be exported in Windows EMF format, 300 dpi, transparent background, inline and compressed, equation text font is Latin Modern, 10pt for in-line with text equations, and 12pt for displayed equations.

18. References; Arial, 10pt, Justified, indentation – hanging 7mm, spacing – at least 10pt

Authors are asked to pay particular attention to the accuracy and correct presentation of references (please read the instructions given bellow carefully), JTST employs an APA Style Formatting as follows:

- For books: Author surname, initials. (year). Book Title. Publishing house and publication place
• For internet sources: Author surname, initials (if available). (year or, n.d. – non-dated (if not available) ). Article or Web-site title. Retrieved on… (date) from (address)
• For quotations page should be indicated inside the text or article

SAMPLE:

Journal article viewed online:
Inside the text: (Curwin, 2010)

Website:
Inside the text: (American Psychological Association, 2010)

Journal article with one author:
Inside the text: (Habel, 2009)

Journal article with six or more authors:
Inside the text: (Amsel et al., 2009)

Book with one author (with city and country for publisher & page number for specific idea or quotation in in-text citation):
Inside the text: (O’Shea, 2009, p. 6)

Book with more than one author (with city and state for publisher):
Inside the text: (Haslam, Reicher, & Platow, 2010)

Designer’s note on image quality
All visuals (jpg files, photos, graphics, tables) should be of high resolution (not less than 300 dpi, image size should not be less than 1 MB, for example, instead of 600 KB), if using images from the internet, make sure you download a bigger size of the picture from the chosen site. Please seek help if you find it difficult to choose the right size of picture.

Usually you can choose option „more sizes” and download the bigger size of the picture that will be shown on the site after choosing the option „more sizes”; in case you are exporting (jpg, photos, graphics, tables) files from any program that you are using, it is advisable to choose the TIF format and fix not less than 300 dpi. If you make print screen, you will have to save the print screen picture NOT in paint, but ONLY in Photoshop (when you create a new page for pasting your print screen picture, you should choose a resolution of at least 300 dpi, NOT RGB, BUT CMYK). Choose the same option that was indicated for exporting above i. e. (TIF format, 300 dpi resolution).

NO INFORMATION WILL BE ADDED AND NO CORRECTIONS WILL BE MADE AFTER THE FILES HAVE BEEN GIVEN TO THE DESIGNER

APA Style

We urge our potential Authors to adopt the American Psychological Associations Format to their research papers and publications.

APA– Automatically Format Bibliographies

Applies to: Microsoft Word 2010, Word 2007

In Microsoft Word 2007 and Word 2010, you can automatically generate a bibliography (or other similar document requiring citations) of the sources you used to write your paper. Each time you add a new citation to your document, Word adds that source so that it appears in the bibliography in the proper format, such as APA.

This information explains how you can automatically insert citations into Word and format bibliographies.

Add a citation after a quote

1. In your Word document, click on the References tab on the main Menu Ribbon.

2. Click the style that you want to use for the citation and source.

3. Click at the end of the sentence or phrase that you want to cite.

4. Click Insert Citation and then select Add New Source.
5. Type in the citation details and then click **OK**.

When you’ve completed these steps, the citation is added to the **Insert Citation** button, so the next time you quote this reference; you don’t have to type it all again.

---

**Create a bibliography from your sources**

If you want to create a bibliography from your sources, do the following:

1. Click where you want to insert a bibliography. Typically they are at the end of a document.
2. On the **References** tab, in the **Citations & Bibliography** group, click **Bibliography**.

Much like the Table of Contents builder in Word, you can select a predesigned bibliography format that includes a title or you can just click **Insert Bibliography** to add the citation without a title.
Bibliography


Works Cited

Designers Note to Authors

Instructions to Authors for submitting Article for Journal publication:

1. All visuals (jpg files, photos, graphics, tables) should be of high resolution (not less than 300 dpi, image size should not be less than 1 MB, for example, instead of 600 KB), if using images from the internet, make sure you download a bigger size of the picture from the chosen site. Please seek help if you find it difficult to choose the right size of picture.
   Usually you can choose option „more sizes” and download the bigger size of the picture that will be shown on the site after choosing the option „more sizes”; in case you are exporting (jpg, photos, graphics, tables) files from any program that you are using, it is advisable to choose the TIF format and fix not less than 300 dpi. If you make print screen, you will have to save the print screen picture NOT in paint, but ONLY in Photoshop (when you create a new page for pasting your print screen picture, you should choose a resolution of at least 300 dpi, NOT RGB, BUT CMYK). Choose the same option that was indicated for exporting above i.e. (TIF format, 300 dpi resolution). The picture should be given in the original format, in a separate file not pasted in word document or any other medium. It is better to indicate in your document / paper where you expect the (jpg files, photos, graphics, tables) images to be placed;

2. All Texts should be written in Arial 10, and Titles should be Arial 12, Bold;

3. All texts used in graphics, tables and visuals should be readable, of the same font, (Arial), and the same size, 10pt if it’s standard text, for title - 12pt and bold;

Please ensure that all texts used from any source are readable, of the same size and font employed in the article.
Article

Sample ARTICLE  

Abstract
This is not a real article. This file is created as a sample for formatting an article for IBSU Journals. We are also trying to follow Editor's expectations of a scientific paper in structuring this sample. Please follow the Guidelines for Authors for details.

Keywords: article, format, structure, style, typesetting

Introduction
There seems to be some inconsistency in the formatting and styling instructions we send to our authors. There are several documents designed to control the formatting and style of the papers. Yet these multiple documents often have confusing and self-contradicting instructions. This paper is created as a sample to help our authors make the right choices when they are in the final stages of their article preparation. Detailed instructions can be found in Guide for Authors.

Methods
We have carefully analyzed all available documents meant to help our potential authors to format their articles. We interviewed the designer and the editor and came up with one consistent list of requirements for the format and style. These instructions can now be found in Guide for Authors. We have followed these instructions to format this paper as well.

Results
In this section of the sample paper we will use tables, graphics and mathematical expressions to illustrate the formats and style chosen for IBSU journals. Create a folder that will contain all of the figures used in your article. Make sure you save the original, high quality images, as requested by our designer. Name these files in such a way that could be easily recognized by the designer, for example, if you are numbering your figures, use “fig1”, “fig2”, etc. or something similar. This folder will have to be submitted with the article.

![IBSU Logo](image)

**Figure 1.** The caption for the figure above needs to be set in the format used here. The source file for the picture has to be submitted with the article. The width of the figure has to be equal to the column width.

Next, we are going to create a table consistent with the formatting guidelines of IBSU. Note that for the tables the caption is placed above the table.

**Table 1.** In this table we are presenting midterm grades of non-existent students in a non-existent course. The width of the table has to be equal to column width.
<table>
<thead>
<tr>
<th>Name</th>
<th>Grade</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name1 Surname1</td>
<td>89</td>
</tr>
<tr>
<td>Name2 Surname2</td>
<td>93</td>
</tr>
<tr>
<td>Name3 Surname3</td>
<td>77</td>
</tr>
</tbody>
</table>

Why is it important for authors to have clear instructions, and why is it important for authors to follow the guidelines? The journals had some issues in the past when printing of the journals was delayed due to inconsistent formatting. The university wishes to produce high quality journals with consistent style and format across all of its faculties. Therefore paying attention to the guidelines is important for
- The authors,
- The university,
- The faculty,
- The designer.

Let us introduce some samples of technical writing. Following the guidelines, let us go to [http://www.codecogs.com/latex/eqneditor.php](http://www.codecogs.com/latex/eqneditor.php) and create some formulas. The following formula was created in Windows EMF format to be used in-line $f^2$ with text as we have done here. The next formula is to be displayed and we use 12pt font size instead of 10pt above

$$\|f\|_2^2 = \int_a^b |f(x)|^2 \, dx.$$  

Create a folder that will contain the pictures of all of your formulas, number them corresponding to the order used in the article. This folder has to be submitted with the article as well.

**Discussion/Conclusion**

We are hoping that publishing with IBSU will be mutually beneficial. We have tried to eliminate possible inconsistencies in our instructions. If you find that some items can be improved, do not hesitate to contact us. The submission instructions has been sent to you (or will be sent to you) in a separate e-mail. The on-line submission process is quite simple and convenient. Do not forget to upload all additional files (pictures).

**References**


*Associate Professor at the Faculty of Engineering and Computer Science, International Black Sea University, Tbilisi, Georgia, e-mail: aakintunde@ibsu.edu.ge and vbaramidze@ibsu.edu.ge